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Release Notes 
The release notes describes the new and enhanced functionality available for Operations Control Logger, 
providing an overview of the most significant changes. 

Note: The product documentation is now available on the AVEVA documentation portal. To comply with the 
portal guidelines, the style and tone of the documentation content has been modified. Hence, the content 
available on the portal may differ slightly from the documentation delivered with the product release. 

Operations Control Logger 23.2 

This Readme provides information about Operations Control Logger version 23.2. Carefully review this section 
for issues that have been resolved in this release, and some known issues you may encounter while using 
Operations Control Logger. 

New Features and Enhancements 

This release supports the installation of the Operations Control Logger 23.2. It contains various fixes and 
improvements since its last release. 

The following new and enhanced functionality is delivered as part of Operations Control Logger 23.2 release. 

• Integrated the latest Visual Studio 2022 Redistributable. 

• This version incorporates several security fixes. 

Resolved Issues 

Operations Control Logger 23.2 includes corrections for the issues listed in the following table. These issues are 
listed by their Defect ID (IMS number), any assigned Service Request (SR) or Case Number with a brief 
description of the defect. 

Defect ID SR/ Case Number Description 

3288511 960332429 Challenge on recovering redundant 
app engine when one of the nodes 
restarted. 

3278933 960407901 Memory Leak 2023 R2: 
PCS.Agent.Exe continuously 
increased memory consumption. 

2998763 960372780 Archestra Logger stopped logging. 

3242602 960395770 Investigated high CPU usage by the 
aaEngine process after reboot. 

Operations Control Logger
Release Notes
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3338604 960412383 AVEVA data store had high memory 
consumption. 

Known Issues 

This section describes known issues in this release of Operations Control Logger. 

Defect ID Service Request/ Case Number Description 

2974924 960362794 Objects suddenly stopps generating 
logs in the SMC with the 
LogMessage function. 

Operations Control Logger
Release Notes
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Get Started with Operations Control Logger 
Operations Control Logger includes key components such as Log Viewer for viewing logged messages, Log Flag 
Editor for managing message categories, and Log Monitor for monitoring the status of local and remote Loggers, 
all of which enhance data management and operational efficiency. 

System requirements 

This section describes the operating system, hardware, and software requirements to install Logger. 

Supported Operating Systems 

Below are the Operating System minimum requirements: 

• Client Operating System (x86 and x64): 

• Windows 8.1 Professional 

• Windows 10 Version 1607 

• Server Operating System (x64 only): 

• Windows Server 2012 

Hardware Requirements 

Below are the basic hardware requirements to install Operations Control Logger. 

• CPU Cores: 4 

• RAM: 4 GB 

Software Requirements 

• A clean installation of Operations Control Logger requires .NET Framework 4.8 and supported Visual C++ 
redist 2019 as prerequisite. 

Port List 

The following ports are used by default: 

• 57727: ocLogger service port 

Important: If you want to change the default ports, be very careful when changing port settings. Doing so may 
impact product operation. 

Operations Control Logger installation 

This section describes the installation steps of Operations Control Logger. 

Operations Control Logger
Get Started with Operations Control Logger

© 2015-2024 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 7



Install Operations Control Logger 

1. Right-click the setup.exe file and select Run as administrator. 

The Operations Control Logger Agreement screen appears. 

2. Accept the End User License Agreement and then select Next. 

3. Select the components that you want to install: 

• Select Operations Control Logger. 

4. Select Next. 

The Ready to Install the Application screen appears. 

5. Select Install to start the installation. 

Once the installation is complete, the installation successful dialog box appears. 

6. Select Finish. 

Install Operations Control Logger silently 

You can install Operations Control Logger silently through command line mode. 

Install Operations Control Logger silently from the command line 

1. Open the command prompt (cmd.exe) as Administrator. 

2. Change the working directory to the folder where you downloaded Operations Control Logger Setup.exe. 

3. Run one of the following commands, depending on whether or not you want the computer to reboot 
automatically. 

To automatically restart the node when installation is complete, enter the following command: 

"C:\...\CD-OCLoggerStandalone\Setup.exe" /silent "C:\Response.txt" 

If you do not want to automatically restart after installation, use the /Silentnoreboot option: 

"C:\...\CD-OCLoggerStandalone\Setup.exe" /silentnoreboot "C:\Response.txt" 

Note: Sample response files, “SampleResponseFiles” are present in CD-OCLoggerStandalone media folder. 

Uninstall Operations Control Logger silently 

You can uninstall Operations Control Logger silently through command line mode. 

Uninstall Operations Control Logger silently from the command line 

1. Open the command prompt (cmd.exe) as Administrator. 

2. Change the working directory to the folder where you downloaded Operations Control Logger Setup.exe. 

3. Run one of the following commands, depending on whether or not you want the computer to reboot 
automatically:To automatically restart the node when uninstallation is complete, enter the following 
command: 

"C:\...\CD-OCLoggerStandalone\Setup.exe" /silentuninstall {64484352-2B13-4C3C-94E6-4AA582C80EB6} 

Uninstall Operations Control Logger 

1. Select the Uninstall or Change a Program option in Windows Control Panel. The list of software installed on 
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your computer appears. 

2. Select Operations Control Logger, and then select the Uninstall/Change. The Modify, Repair or Remove 
Installation dialog box appears. 

3. Select the Remove option, and then Select Next. The confirmation dialog box appears. 

4. Select Uninstall. The component is uninstalled, and the complete uninstallation dialog box appears. 

5. Select Finish. 

Repair Operations Control Logger 

1. Select the Uninstall or Change a Program option in Windows Control Panel. The list of software installed on 
your computer appears. 

2. Select Operations Control Logger, and then select the Uninstall/Change. The Modify Repair or Remove 
Installation dialog box appears. 

3. Select the Repair option, and then select Next. The Confirm Repair dialog box appears. 

4. Select Repair. The complete repair dialog box appears. 

5. Select Finish. 

Installation update 

If all nodes are not upgraded from a lower version to a newer version, you might encounter compatibility issues 
while connecting to a remote log viewer/log monitor from older to newer version and vice versa. To resolve the 
issue, you need to set the registry key value. This action will disable some security changes and work in a non 
authentication mode. 

Set registry key value 

1. For 64-bit node: 

a. Navigate to Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\ArchestrA\Framework\
Logger. 

b. Create a DWORD key EnableCompatibleMode and set the key value to 1. 

c. Navigate to Computer\HKEY_LOCAL_MACHINE\SOFTWARE\ArchestrA\Framework\Logger. 

d. Create a DWORD key EnableCompatibleMode and set the key value to 1. 

2. For 32-bit node: 

a. Navigate to Computer\HKEY_LOCAL_MACHINE\SOFTWARE\ArchestrA\Framework\Logger. 

b. Create a DWORD key EnableCompatibleMode and set the key value to 1. 

3. Restart the machine. 
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Get Started with Log Viewer 
You can use the the Log Viewer to view messages logged to the Logger. The Logger is a system service that 
records, maintains, and manages messages from Logger-enabled components. Additionally, the Log Viewer 
records the date and time when HMI/SCADA related components start and any error conditions that occur. 

Start Log Viewer 

The Logger and Log Viewer utilities are automatically installed on any computer when you install a Logger 
enabled component. 

Caution: Do not disable the Logger service at any time. 

The Logger is a background process that stores messages in the system log file. You can manually start the Logger 
or configure it to start automatically. 

• Automatic means the Logger starts when the computer starts. 

• Manual means you must start the Logger from the System Services utility in the Windows Control Panel. 

You can also customize which messages you want to log with the Log Flag Editor. For more information, see Log 
Flag Editor. 

Note: Always check logged messages before calling technical support. 

You use the Log Viewer to view messages sent to the Logger. You can customize the format of this utility. For 
more information about customizing the Log Viewer, see Configuring the Log Viewer 

Start Log Viewer (system management method) 

1. Select Start, navigate to AVEVA. 

2. Select Operations Control Management Console. 

The Operations Control Management Console appears with the Log Viewer listed in the left pane. 

3. Double-click Log Viewer to expand its groups. The Local group is listed beneath the Default Group. 

Executable method 

1. Navigate to C:\Program Files (x86)\Common Files\ArchestrA. 

2. Right-click aaLogViewer.exe, and then select Run as Administrator. Alternatively, double-click 
aaLogViewer.exe. 

The User Account Control dialog box appears. 

3. Select Yes. 

The Log Viewer window appears 

During installation, users are added by default to the aaLoggerProcess group. To perform operations like 
configuring, setting Log Flags, and purging, you need to be an administrator or member of aaLoggerManagement
group. 
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If a user is not a part of the aaLoggerManagement group, they must be manually added it. 

Add user to aaLoggerManagement group 

1. Open the Run dialog and type lusrmgr.msc, and select OK. 

2. Under Groups, select aaLoggerManagement group. 

3. Double-click on the aaLoggerManagement group. 

4. Add the user as a member and select Add. 

Work with Log Viewer 

You use the Log Viewer to view messages sent to the Logger. By using the filter, mark, find, time range, and other 
functions of the Log Viewer, you can simplify and specify the messages that are shown. Additionally, you can use 
the Log Viewer to save logged messages to a file and view logged messages previously saved to a file. 

Troubleshoot problems 

The Log Viewer is a diagnostic tool that you can use to gather information about potential issues in your 
ArchestrA-enabled program. By examining logged messages, you can determine whether all processes are 
functioning correctly. 

• Error messages are highlighted in red, indicating malfunctioning processes. 

• Warning messages appear in yellow, indicating major system events. 
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Troubleshoot problems using Log Viewer 

1. Gather as much information about the process that is malfunctioning. 

For example, if you attempted to deploy an object in the IDE and a message was shown stating the 
deployment was not completed. 

2. Note the function you attempted and the message you received. 

3. Open Log Viewer. 

4. Select the node your product is located on. 

5. Look for red and yellow messages. 

Note: Use the information you collected about the failed process to search for clues in the logged messages. 

6. Find or filter data. Do any of the following: 

• On the View menu, select Find to single out messages by message text or other category of data. 

• On the View menu, select Filter to reduce the number of shown messages based on message, time 
range, or terminal session criteria. 

Configure Logger storage options 

You can specify the location of the files containing the Logger messages and other options related to Logger 
storage. 

Caution: If you change the Store Log Messages In This Path setting, you may no longer be able to view 
previously logged messages. Before changing this setting, you should Export the current messages to a log file. 
This path must be on your local hard drive. 

Configure Logger storage options 

1. In the Log Viewer, select an Logger node. 

2. On the Action menu, select Configure. 

The Configure dialog box appears. 

3. Select the Storage tab. 

4. In the Store Log Messages in this Path box, change the location of your logged files. 

5. Limit the quantity of messages and the amount of disk space used to store messages with two additional 
storage page options: 

Delete Log Messages older than _ days. 

Limit the total disk space used for storing log messages to _ MB. 

Note: The Logger deletes messages beginning with the oldest ones first. These two options perform an OR 
operation. In other words, when either setting is encountered, messages are deleted. If your computer has a 
large hard drive, you can set these options at or near their maximum allowed values (365 days, 10 GB disk 
space). 

6. Select OK to save the new configuration or Cancel to revert to the current settings. 
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Search for messages 

You can use either the Find or Go To dialog box to locate a message. 

• Find is a general search function based on five categories of criteria that map to column headings in the 
message window. 

• Go To is a search function based on bookmarks you previously set. For instructions about using the Go To 
dialog box, see Use bookmarks. 

Note: The Process ID and Thread ID categories require numeric data; the others accept alphanumeric 
characters. You can use both AND and OR operations (multiple categories on multiple rows) to perform 
complex search functions. 

Find a message 

1. On the View menu, select Find. 

2. On the first row, choose a category you can use to logically isolate a particular set of messages. Double-click 
the category box in the data entry window and type the desired criteria. After typing search data, select 
outside of the category box to exit edit mode. You can repeat this step over multiple categories to perform 
an AND operation. In other words, the search function finds only those messages that meet all criteria. 

3. To add another row of criteria, right-click anywhere in the data entry window and select Add. Columns 
perform an OR operation. In other words, the search function finds those messages that meet the criteria on 
one row or the criteria on other rows. 

4. To remove criteria you have entered in a category box, right-click the box and select Clear Field. To remove 
an entire row, right-click the row and select Delete. To remove all search criteria, select the Clear All. 

5. After you have set search criteria, select Find Next. The first message that meets your criteria is highlighted 
in the message window. 

6. Select Find Next again to move to the next message that meets the criteria. 

7. Select Cancel to close the dialog box. 

Use bookmarks 

You can apply labels to individual messages so that you can easily find them. These labels are called bookmarks. 
They differ from marks in that bookmarks are associated with specific messages while marks are messages added 
below the message that is currently last in the log. For more information, see Mark message log. 

You cannot enter duplicate bookmark names, and a message can have only one bookmark. 

The message window can display a Bookmark column, which is initially hidden by default. 

Show bookmarks 

1. Right-click the column header of the message window and select Show. 

2. In the Choose Columns dialog box, select Bookmarks in the Columns Hidden box, select the Show button to 
move it to the Columns Shown box, and then select OK. 

The Bookmark column is added at the far right of the column header. 

3. Select and drag it to another position if you want. When the text of a bookmark in the Bookmark column is 
partially obscured, point to it to display the entire bookmark like a tooltip. 
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Add a regular or fast bookmark 

You can set bookmarks in two ways: adding a regular bookmark that you can name, and setting a fast bookmark 
that is named for you. 

Add a regular bookmark 

1. Right-click the message, and then select Add Bookmark on the Bookmark submenu. 

2. In the Add Bookmark dialog box, either accept the default name (Bookmarkx where x is a number in an 
ascending sequence) or change it with something more descriptive. You can change the bookmark name in 
the Bookmarks dialog box at a later time. 

3. Select OK to set the bookmark or Cancel to terminate the process. 

Set a fast bookmark 

1. Right-click the message and select Fast Bookmark on the Bookmark submenu. A default naming sequence is 
applied to the message (Bookmarkx where x is a number in an ascending sequence). Alternatively, you can 
set a fast bookmark by selecting the message and clicking the Fast Bookmark icon on the toolbar. 

2. Change the bookmark name to something more descriptive, if necessary, in the Bookmarks dialog box at a 
later time. 

Note: You cannot go to bookmarked messages that are currently hidden by a filter. If you cannot find the desired 
message, remove the filter and try again. 

Find a bookmarked message 

1. On the View menu, select Go To. 

2. In the Go To dialog box, enter the name of the message’s bookmark by typing it in the box or selecting from 
the list. 

3. Select Go To. The Go To dialog box remains open. 

4. Use the Previous and Next to go to the nearest bookmarked message above and below, respectively. 

5. When you are done searching, select Close. 

Note: Bookmarks are not saved when you quit the Log Viewer application. To mark your message log more 
permanently, use the Mark command on the View menu. 

Manage bookmarks 

To manage bookmarks: 

1. On the View menu, select Bookmarks. 

The Bookmarks dialog box appears. 

2. You can manage current bookmarks and create new ones. The bookmark list shows the current set of 
bookmark names and associated Message No. (the same number as the No. column in the message 
window). The bookmark list provides several functions. 

3. For example, to rename a bookmark, select it, press F2, and then type the new name. 
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Each bookmark must have a unique name. You cannot bookmark two messages with the same name. 

4. To go to a bookmarked message, double-click on the message from the list or select it and select Go To. 

5. To remove one or all bookmarks from your logged messages, select a message and select Remove, or select 
Remove All. 

6. To add a new bookmark, select the message you want to bookmark in the message window and select Add. 
This function is comparable to a fast bookmark. Rename it by pressing F2. 

7. When you are done, select Close. 

Mark message log 

Marks are messages you can insert into your message log to designate events or segments of messages. They 
differ from bookmarks in that marks are messages added below the message that is currently last in the log 
while bookmarks are labels associated with existing messages. For more information, see Use bookmarks. 

You can create marked messages in two ways: adding a regular mark that you can name and adding a fast mark 
that is named for you. 

Add a regular mark message 

1. On the View menu, select Mark. 

The Mark dialog box appears. 

2. Either accept the default name (Mark) or overwrite it with something more descriptive. You cannot change 
the marker name at a later time. 

3. Select OK to add the marker message to the end of all logged messages. 

Add a fast mark message 

• Select the Fast Mark icon on the toolbar. A marker message with the default name (Mark) is added to the 
end of all logged messages. 

Filter messages 

During normal operations in an ArchestrA environment, many messages are logged to the Logger. If a program is 
malfunctioning or some component has been configured outside of acceptable ranges, the number of messages 
can increase significantly. You can reduce the number of messages being shown in the message window with the 
Filter dialog box. 

Use filtering to display a subset of all logged messages based on specified criteria. The Filter dialog box provides 
three sets of criteria you can use to reduce the number of messages shown. You can use one or more of these 
sets of criteria at a time to help troubleshoot problems in the ArchestrA environment 

Note: Filtering does not delete logged messages, but only affects the display of messages in the message 
window. To view all logged messages again, disable the filter by clicking the Enable/Disable Message Filter icon 
on the toolbar or clearing the Show Time and End Time check boxes. You can enable the filter at a later time 
because the filtering specifications are still set in the background. 

Filter messages based on message characteristics 

1. On the View menu, select Filter. 
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2. On the Filter dialog box, select the Messages page. The first column in the data entry window is Type. There 
are two possible types of criteria: Show and Hide. When a row is type Show, messages that meet the criteria 
set are shown in the message window. When a row is type Hide, messages that meet the criteria set are not 
shown in the message window. All other columns in the data entry window map to columns shown in the 
message window. The first row in the data entry window is not editable and cannot be deleted, although you 
can disable it by clearing the check box. 

Add filtering criteria 

1. Select the New Filter icon. 

A new Show type row appears. 

2. Select the Type box and double-click to switch to Hide type. 

3. Double-click a category, and type filtering criteria. 

4. Add another row by right-clicking a category header and select Add on the shortcut menu. 

The new row is added and the category box is set to edit mode automatically. 

5. When you are finished typing the filtering criteria, select outside of the box. 

To filter messages based on multiple criteria, use more than one category box in a row or more than one row. 
Data rows perform an AND operation that filters messages that meet both criteria. Data columns perform an OR 
operation that filters messages that meet either criteria. 

Delete a row 

• Select a row and select the Delete Filter icon. 

Delete all rows 

• Select Delete All. 

Remove a filter criteria 

1. Right-click in the box and select Clear Field. 

2. Select OK to set the filtering criteria and close the Filter dialog box. Alternatively, select Cancel to close the 
Filter dialog box without setting filtering criteria. 

Note: After you have set filtering criteria, you can switch filtering on and off with the Enable/Disable Message 
Filter icon on the toolbar. Enable the filter to show only the messages that match the filtering criteria. Disable 
the filter to show all logged messages. 

Filter messages based on time range 

To filter messages based on a time range: 

1. On the View menu, select Filter. The Filter dialog box appears. 

2. Select the Time Range page. 

3. To filter based on a start time, select Messages On in the From box. The date and time options appear. 

4. Select in any field and type the target date. Alternatively, select the arrow in the date box to display a 
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calendar of the current month. Use the right and left arrows to select the target date. 

5. Select the Time Box and scroll up or down. 

6. To filter based on an end time, select Messages On in the To box. The date and time options appear. Use 
same steps described in steps 4 and 5. 

7. Select OK to set the filtering criteria and close the Filter dialog box. 

The message window immediately shows messages based on this time range criteria. If you use a From setting, 
the Start Time check box in the time header is automatically selected and the new filter settings are shown. If 
you use a To setting, the End Time check box in the time header is automatically selected and the new filter 
settings are shown. 

Filter messages based on terminal session 

To filter messages based on a terminal session: 

1. On the View menu, select Filter. 

2. On the Filter dialog box, select the Terminal Sessions page. The first column in the data entry window is 
Type. There are two possible types of criteria: Show and Hide. When a row is type Show, messages that 
meet the criteria set are shown in the message window. When a row is type Hide, messages that meet the 
criteria set are not shown in the message window. The first row in the data entry window is not editable and 
cannot be deleted, although you can disable it by clearing the check box. 

Add filtering criteria 

1. Select the New Filter icon. 

A new Show type row is shown. 

2. Select the Type box to switch to Hide type. 

3. Double-click the Session ID box and type filtering criteria.Alternatively, add another row by right-clicking a 
column header and clicking Add. 

The new row is added and the box is set to edit mode automatically. When you finish typing the filtering 
criteria, select outside of the box. 

Filter messages based on multiple sessions 

• Use more than one row. Data columns perform an OR operation to filter messages that meet either criteria 

Delete a row 

• Select the row and select the Delete Filter icon. 

Delete all rows except the first one 

• Select Delete All. 

Delete session filtering criteria 

1. Right-click in a Session ID cell and select Clear Field from the shortcut menu. 
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2. Select OK to set the filtering criteria and close the Filter dialog box. 

Note: After you set filter criteria, you can switch filtering on and off with the Enable/Disable Message Filter icon 
on the toolbar. 

Purge messages 

Logged messages are purged automatically according to parameters set on the Storage page of the Configure 
dialog box. You can use the Purge dialog box to remove messages before reaching those limits. For more 
information, see Configuring Log Viewer. 

Caution: You cannot undo the Purge function. Several Log Viewer functions like CTRL+R clear the messages 
shown in the message window, but have no effect on the messages logged to the Logger. If you want to simply 
clear the Log Viewer’s message window, do not use Purge. Purge actually deletes the messages from the Logger. 

Purge existing messages from the Logger 

1. From the Action menu, select Messages, and then Purge. 

The Purge dialog box appears. 

2. Select the option you want. Alternatively, select Purge All Log Messages to clear all messages from the 
Logger. 

3. Select Purge Log Message Created Before to clear all messages from the Logger before a specified date and 
time. 

Caution: In the next step, after you select OK, you cannot reverse this process. 

4. Select OK to execute the type of purge you selected. 

You are prompted to create a log file of the messages to be purged. 

5. Select Yes to create a backup file or No to continue with the purge. Do one of the following: 

• If you select Yes, the Create Back-Up As dialog box appears. Set the path and file name for the backup 
file and select Save. 

• If you select Cancel, the purge is executed without making a backup file. 

Log Viewer user interface 

This section describes the Log Viewer user interface. 

Note: Aspects of the Log Viewer may vary in appearance when installed on computers running different versions 
of Microsoft Windows. Also, the version of the MMC installed on your computer may affect the appearance of 
the Log Viewer. 

Menu bar 

Log Viewer commands are on the Action and View menus. These menus are dynamic depending on which item 
is selected in the Console Tree or Message Window. 

See the lists below. 
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Action Menu 

About Log Viewer Opens a dialog box showing software version and 
other information 

Configure Opens a dialog box to set global parameters for your 
local Log Viewer and the Logger you are currently 
connected to. 

Connect This command provides a submenu containing Local 
and Remote commands. Use the Local command to 
connect to the Logger on your computer. Use the 
Remote command to open the Connect dialog box to 
specify a remote computer from which to view its 
logged messages. The remote node is always added 
under Default Group. 

LogFlags Starts the Log Flag Editor to select the types of 
messages logged by the Logger. 

Messages Opens a submenu containing Export, Purge and Print 
commands. 

• Export: Saves all currently shown messages to 
another file. 

• Purge: Deletes messages from the Logger. 

• Print: Prints current messages. 

New Opens a submenu containing Node and Node Group 
commands. Use these two commands to organize 
local and remote nodes to monitor and manage 
logged messages. 

• Node: Adds a node under a node group. 

• Node Group: Creates a new node group under 
which you can add and group nodes. 

Open Log File Opens a log file containing logged messages. 

View Menu 

Filter Set criteria for displaying sets of logged messages. 

Find Search through messages according to specified 
criteria. 
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View Menu 

Go To Go to a message based on its bookmark name. 

Bookmarks Manage bookmarks in your message log. 

Mark Add a marker line after the last message. Enter 
explanatory text for setting the mark in that position. 

Choose Columns Customize the column headings in the message 
window. 

Toolbar 

The Log Viewer Toolbar gives quick access to frequently used commands. The toolbar is dynamic depending on 
which item is selected in the console tree or message window. Here is a list of all possible Toolbar icons. 

Icon Icon Name Description 

Back Jump backwards through previous 
selections in the console tree. 
Helpful if you have hidden the 
console tree. 

Forward Jump forward through previous 
selections in the console tree. 
Helpful if you have hidden the 
console tree. 

Up One Level Select the next item up in the 
console tree. Helpful if you have 
hidden the console tree. 

Show/Hide Console Tree Toggle the console tree on and off. 

Delete Delete the selected item in the 
console tree. 

Refresh Update the messages in the 
message window. 

Export List Export the console tree as an ASCII 
(.txt) file. 

Help Open help for the MMC, the Log 
Viewer and other OCMC utilities. 
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Icon Icon Name Description 

Filter Set filtering criteria for viewing only 
certain logged messages. 

Enable/Disable Message Filter Toggle filtering on and off. 

Find (Ctrl+F) Search for a logged message. 

Fast Bookmark Set a bookmark for the highlighted 
message. 

Fast Mark Mark sections of messages for 
special purposes. 

Export Export all messages currently 
shown in the message window. 

Print (Ctrl+P) Allows you to print all messages 
shown in the message window. 

Print Preview Show messages as they would be 
printed. This icon is the only access 
to this function. 

Note: You can select the MMC Customize command on the View menu to add and remove icons on the toolbar. 

Console tree 

The console tree is the hierarchical structure displaying the items available to the console, such as the Default 
Group, the Local node, remote nodes, and a log file folder. Other items can include folders, snap-ins, controls, 
web pages, and other tools. 

If the Local node is part of a Galaxy, the Galaxy is shown as a group. All platforms in the Galaxy are automatically 
shown beneath the Galaxy group. 

• You can rename the Default Group. 

• You can delete nodes from the Default Group. 

• You cannot rename the Local node, the Galaxy group, nor any platform nodes. 

• You cannot delete the Local node, the Galaxy group, nor any platform nodes. 

• You cannot add or remove nodes in the Galaxy group. 

The contents of the message window change as you select items in the console tree. 

Details pane 

The details pane has four main elements. 
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Element Description 

Description Bar Shows the name of the item selected in the console 
tree. This element is hidden by default. Select 
Customize on the View menu to display it. 

Time Header Shows the time range set in the Filter dialog box. To 
enable each time setting, Start Time and End Time, 
select the check box. To disable either time range 
setting, clear the check box. 

Column Header Shows descriptive titles for each shown column. You 
can rearrange the headers by clicking and dragging. To 
further customize headers, select Choose Columns on 
the View menu. 

Message Window Shows all logged messages, just those messages 
determined by filtering criteria, or just messages 
contained in a log file. To view details of a specific 
message, double-click it. 

Shortcut menus 

A shortcut menu is a set of commands that appear when you right-click an item in the user interface. The Log 
Viewer provides several shortcut menus in the console tree and message window areas. The shortcut menus are 
dynamic depending on which item is in focus, which item you right-click, and which commands apply to the item. 

The same commands in shortcut menus are sometimes shown in the menu bar. Some dialog boxes also use 
shortcut menus, and those commands do not appear on the menu bar. For more information about individual 
dialog boxes, see Configure dialog boxes. 

Shortcut keys 

The following table lists shortcut keys you can use to issue Log Viewer commands. 

Shortcut Key Associated Menu Command Description 

ALT+F2 Bookmarks on the View menu Opens the Bookmarks dialog box. 

CTRL+A Selects all messages in the message 
window. 

CTRL+C Copy on Shortcut menu in text box 
or on selected message 

Copies the selected messages to 
clipboard. 
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Shortcut Key Associated Menu Command Description 

CTRL+F Find on the View menu Opens the Find dialog box to search 
messages in the message window. 

CTRL+F2 Sets or removes a bookmark. 

CTRL+G Go To on the View menu Opens the Go To dialog box to 
choose a bookmark to go to. 

CTRL+P Print on Messages submenu of the 
Action menu 

Prints displayed log messages. 

CTRL+R Clears the message window by 
setting and enabling the current 
time as the Start Time for the filter. 

CTRL+SHIFT+F2 Removes all bookmarks in the 
message window. 

DELETE Delete on the Action menu Deletes the selected Node or Node 
Group from the console tree. 

ENTER Details on shortcut menu on 
selected message 

Opens the Message Details dialog 
box for the selected message. 

F2 From the console tree, renames 
the selected node group. 

From the message window, goes to 
the next bookmark. 

In Bookmarks dialog box, puts 
selected bookmark in rename 
mode. 

F5 Refresh on the Action menu Refreshes the message window. 

SHIFT+F2 Goes to the previous bookmark. 
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Configure Log Viewer 

See the following dialog boxes to configure the Log Viewer. 

Add bookmarks 

You can insert a bookmark to return to a message later. 

Add bookmarks 

1. Right-click a message in the message window. 

2. On the Bookmark menu, select Add Bookmark. 

The Add Bookmark dialog box appears. 

3. Accept the default name or create your own. 

4. Select OK. 

You cannot enter the same bookmark name for more than one message, and each message can have only one 
bookmark. 

Manage bookmarks 

Manage bookmarked messages in your message log. 

Manage bookmarks 

1. On the View menu, select Bookmarks. 

The Bookmarks dialog box appears. 
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2. Do any of the following: 

• Rename a bookmark by selecting it and pressing F2. 

• Go to a message by double-clicking the bookmark in the list or by selecting it and clicking the Go To 
button. 

• Add a bookmark to the list that is associated with the message selected in the message window. The 
new bookmark is given a default name; press F2 to rename it. 

• Remove the selected bookmark from the list. 

• Remove All bookmarks from your logged messages. 

3. Select Close. 

Manage columns 

Manage columns in the Message window or in the Message Details window. 

Manage columns 

1. On the View menu, select Choose Columns. Alternatively, right-click a column heading, and select Show. 

The Choose Columns dialog box appears. 
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Show a column 

• Select a column name in the Columns hidden box and select Show. 

Hide a column 

• Select a column name in the Columns shown box and select Hide. 

Shift the position of a column 

• To move a column left or right, select a column name in the Columns shown box and select the Up or Down 
arrow. 

Note: These settings are saved to your user profile, and are shown on subsequent uses of the Log Viewer. 

Configure dialog boxes 

Use this dialog box to set global parameters for your local Log Viewer and Logger. 

The Configure dialog box has two pages: Log Viewer and Storage. 

Changes to settings on the Storage page of this dialog box affect the Logger you are currently connected to, 
including any Loggers located on remote computers. 

Caution: If you intend to change storage parameters for your local Logger, ensure that you are connected to it 
(select Local in the console tree). Also, be careful when changing default values on either page of this dialog box 
(such as the total disk space allowed for storing messages). Changes to these values can impact overall system 
performance. 

For more information about configuring the Log Viewer, see Configuring the Logger Storage Options 

To Open the dialog box, select Action, and then select Configure. 

The Configure dialog box appears. 
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Log Viewer page 

The Log Viewer tab has the following options: 

• Check for new log messages every ... milliseconds: Set how often your local Log Viewer checks for new 
messages logged to the Logger you are connected to. The default value is 1000 ms, the minimum is 100 ms, 
and the maximum is 3600000 ms (1 hour). 

Caution: Setting a very small millisecond interval can impact system performance. 

• Enable Live Scrolling: Enable or disable live scrolling in the message window. 

• When live scrolling is enabled and you are viewing the end of the shown logged messages, a new 
message that appears on-screen causes the message at the top of the message window to disappear 
from view. 

• When live scrolling is disabled, you must scroll down to see new messages appended to the list of 
messages. 

• Keep Log Viewer Always on Top of Other Windows: Keep the Log Viewer on your screen when you switch 
programs or windows. 

• Cache Only ... Messages in the View: Set the maximum number of messages stored in cache. 

• Show Only the First ... Characters in the Message Column: Set the maximum number of characters for any 
message in the Message column. The maximum is 8,192. 

Storage page 

Select the Storage tab on the Configure page to open the Storage page. 

The Storage tab has the following options: 

• Store Log Messages in this Path: Set the path to the folder for all logged messages. 

WARNING! In the next step, if you change the path, you will no longer be able to view messages previously 
logged to files in the current path. Before changing this path, we recommend that you first export all 
messages to a file. Use the Export command on the Messages submenu of the Action menu to create the 
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export log file (.aaLGX extension). Then, you can view those messages by clicking Open Log File on the Action 
menu and opening the export log file. 

1. Either type the path. Alternatively,Browse to explore. Network drives are not selectable. Select OK. 

2. Delete Log Messages Older Than ... Days: Type the number of days after which logged messages are 
deleted, beginning with the oldest ones. Default value is 0 days (unlimited), maximum is 365 days. 

WARNING! In the next field, if you set the value to zero (0) it could compromise the integrity of the 
components of the application running on that computer. 

• Limit the Total Diskspace Used for Storing Log Messages to ... MB: Type the size limit (in megabytes) of disk 
storage allowed for all logged messages. The maximum value is 10000 (10 GB). 

Note: The Delete Log Messages Older Than ... Days and Limit the Total Diskspace Used for Storing Log 
Messages to ... MB parameters operate as an OR function. When either condition is met, logged messages 
are deleted, beginning with the oldest. 

View remote logger messages 

You can view messages stored by a Logger on a remote computer. 

After you connect to the remote Logger, you can use the Filter, Find, and other Log Viewer functions to 
customize the messages. 

The Log Flag Editor does not work with remote Loggers. 

Connect to a remote Logger 

1. Select the Action menu, point to Connect, then select Remote. 

The Connect dialog box appears. 

2. Type a remote computer name in the text box, choose one from the drop down list, or Select Browse. 

The Browse Nodes dialog box appears. 
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3. Select one of the nodes and select OK. 

Your selection appears in the Computer Name field of the Connect dialog box. 

4. Select OK to establish the connection and display messages from that Logger. 

Export log messages 

You can export the currently shown log messages to a log file. Log files have an .aaLGX extension. The default file 
name is LogExport with the current date in the format (mddyyyy) appended as a suffix. You can 
edit the name of a log file but not its extension. 

Export log messages 

1. From the Action menu, select Messages, then Export. 

The Export dialog box appears. 
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You can update the file name, but the Log file location cannot be changed. 

The Log Viewer provides two additional options: 

• Export only messages matching the current filter: Export only messages that meet the current filtering 
criteria. 

• The Export in the background option is useful when you export a large number of logged messages, which 
could take a long time to complete. 

• If you clear this check box, Log Viewer commands and functions are unavailable until all messages are 
exported. 

• If you select this check box, you can then use all of the commands and functions of the Log Viewer while 
export is in progress. 

Filter messages 

Filter logged messages according to criteria you select. 

Filter messages 

• From the View menu, select Filter. 

The Filter dialog box appears. 
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Messages page 

Select the Messages tab to open the Messages page. 

The Messages page has the following options: 

• Each column, except Type, maps to a column heading in the Message Window. 

• The first row (Error Warning in the LogFlag column) is not editable and cannot be deleted, although you can 
clear the Show check box. 

• Data rows perform an AND operation (filter for messages that meet both criteria). 

• Data columns perform an OR operation (filter for messages that meet either criteria). 

• Use both AND and OR operations (multiple categories on multiple rows) to set complex filters. 

• New Filter icon: Use to add a new row of filter criteria. After setting filtering criteria, the check box is 
automatically enabled for that row. 

• Delete Filter icon: Use to remove a highlighted row of filter criteria. 

• Delete All: Use this button to clear all filter criteria from this page. 

Set a filter 

1. Select the check box of a new row to toggle between Show and Hide. 

2. Double-click a category cell to type the filter criteria. 

3. Select outside of the cell to set that criteria. 

The Messages page also has two shortcut menus. When a category cell is in edit mode, right-click in the cell to 
display Microsoft® edit commands, such as copy and paste. Right-click outside a category cell to display the 
following commands: 

• Clear Field: Erase the data in a category cell. 

• Add: Add another row of filtering criteria. 

• Delete: Delete a row of filtering criteria. 
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Use the Enable/Disable Message Filter icon on the toolbar to toggle on and off the filtering criteria you have set. 

Time range page 

Select the Time Range tab to open the Time Range page. 

The Time Range page has the following options: 

• From and To: Set start and end points to display Logger messages. Select between First Message, Last 
Message and Messages On. 

• Select First Message to display messages beginning with the first one stored in the current log file. 

• Select Last Message to display messages ending with the last one stored in the current log file. 

• Select Messages On to enable the beginning date and time for messages you want to display. 

• To change date and time settings, scroll up or down to the target value. 

• Select the down arrow in the date box to display a calendar in which you can select the desired date. 

• Use the right and left arrows in the calendar to move between months. 

The filter specifications you configure on this page are immediately shown in the time header of the details 
pane. 

• If you used a From setting, the Start Time check box in the time header is automatically selected and the 
settings on this page of the Filter dialog box are shown. 

• If you used a To setting, the End Time check box in the time header is automatically selected and the settings 
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on this page of the Filter dialog box are shown. 

Note: This function does not delete logged messages, but only affects the display of messages in the 
message window of the Log Viewer. To view all logged messages again, clear the Start Time and End Time 
check boxes. 

Terminal sessions page 

Select the Terminal Sessions tab to display the Terminal Sessions page. 

The Terminal Sessions page has the following options: 

• The Session ID column maps to a column heading you can display in the message window. 

• The Type column and its enabling check box determine whether the criteria set in the Session ID column is 
shown or not. 

• The first row is not editable and cannot be deleted, but you can select or clear the Show check box. 

• Double-click in the Session ID cell to type filter criteria. 

• Select outside of the cell to set that parameter. Data columns perform an OR operation. That is, they filter for 
messages that meet either criteria. 

• New Filter icon: Add a new row of filter criteria. 

• Delete Filter icon: Remove a highlighted row. 

• Delete All: Clear all filter criteria from this page. 

The Terminal Sessions page has two shortcut menus. When a Session ID cell is in edit mode, right-click in the cell 
to display Microsoft® edit commands, such as copy and paste. Right-click outside a Session ID cell in edit mode 
to display the following commands: 

• Clear Field: Erase the data in a Session ID cell. 

• Add: Add another row of filtering criteria. 

• Delete: Delete a row of filtering criteria. 

Use the Enable/Disable Message Filter icon on the toolbar to toggle on and off the filtering criteria you have set. 
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Find a message 

• From the View menu, select Find. 

The Find dialog box appears. 

Use the five search categories, Process ID, Thread ID, LogFlag, Component, and Message to search through 
messages shown in the message window. These categories map to column headings in the Log Viewer message 
window. 

Note: The Find function searches only through messages currently shown. If you have applied a filter, only those 
messages are included in your search. If you want to search all logged messages, select the Enable/Disable 
Message Filter icon on the toolbar, and then run your search. Also, if you are currently viewing messages saved 
in a log file, only those messages are included in your search. If you want to search runtime messages, select the 
node in the console tree under Default Group, and then run your search. 

For more information, see Search for messages. 

The Find dialog box has the following options: 

• Data entry window: Use this window to specify search criteria. The Process ID and Thread ID categories 
require numeric data; the others accept alphanumeric characters. Double-click a category box to type search 
data. Select Add on the shortcut menu to specify another row of search criteria. Data rows perform an AND 
operation (search for messages that meet both criteria). Data columns perform an OR operation (search for 
messages that meet either criteria). Use both AND and OR operations (multiple categories on multiple rows) 
to perform complex searches. 

• Find Next: Select to search for the first message that meets the search criteria in the data entry window. 
Repeat to find the next message that also meets the search criteria. 

• Cancel: Select to close the Find dialog box without searching for a message. 

• Clear All: Select to erase all search criteria from the data entry window. 

The Find dialog box provides two shortcut menus. When a category box is in edit mode, right-click in the cell to 
show standard Windows edit commands, such as copy and paste. Right-click outside a category cell to display 
the following commands: 

• Clear Field: Use to erase the data in a category box. This command is only available when you right-click in a 
category cell that has data. 

• Add: Use to add another row of search criteria. The column you right-click is put in edit mode. 

• Delete: Use to delete a row of search criteria. The row you right-click is deleted. 
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Go to a specific message 

You can go to a specific message in the message window that has been bookmarked. 

Note: You cannot go to bookmarked messages that are currently hidden by a filter. If you cannot find the desired 
message, disable filtering and try again. 

For more information, see Manage bookmarks. 

• From the View menu, select Go To. The Go To dialog box appears. 

The Go To dialog box has the following options: 

• Enter Bookmark Name: Type the bookmark name or select one from the list. 

• Go To: Select to go to the message highlighted. 

• Previous: Highlight the previous bookmarked message. 

• Next: Highlight the next bookmarked message. 

Enter a marker message 

Enter a time stamped entry in the Logger. 

• From the View menu, select Mark. 

The Mark dialog box appears. 

The text you type in the Enter the Marker Message to Log box is shown in the Message column of the resulting 
marked message in the Logger. The marked message becomes a time stamped entry as shown in the message 
window below. 

Default text is Mark. Two marked messages are shown in the image below. 
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Caution: When connected to a remote node, the Mark command places a message in the remote computer’s log 
file. If you do not want to make actual changes to the remote log file, use the Bookmark or other Log Viewer 
commands that affect only your display of those messages and do not actually affect the remote log file. 

View message details 

View messages and details about messages in the Message Details dialog box. 

Double-click a message in the message window to open the Message Details dialog box. 

• Scroll through messages by clicking the up and down arrows. 

• Select one of the five column heads, Process ID, Thread ID, LogFlag, Component, or Message to sort 
messages according to category. 

Open a log file 

From the Action menu, select Open Log File. The typical Microsoft open dialog box appears. Use this dialog box 
to locate and open a log file of saved messages. 

After you select the desired log file and select Open, the saved log messages appear in the message window. 

The path and name of the opened log file are shown and highlighted in the console tree below Opened Log Files. 
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Note: Opening a log file does not affect the message logging process in the background, and you can view those 
messages by clicking Local or another node in the console tree. 

When you are viewing an opened log file, you can do filtering, searching, printing, and exporting functions on the 
messages. For example, you can filter the contents of the log file and then export just that subset of messages to 
another log file. After you apply a filter to the contents of a log file, you must select Refresh on the Action menu 
to see the results. 

Print dialog box 

Print shown log messages 

• From the Action menu, select Messages, and then Print. 

The Microsoft Print dialog box appears. 

Purge dialog box 

Older messages are automatically purged from the Log Viewer after they exceed the maximum number of days 
specified with the Delete Log Messages Older Than ... Days option of the Configure dialog box. Also, you can 
manually delete messages from the Logger using the Purge dialog box. 

Caution: Export all logged messages before you purge messages from the Logger. The purge function deletes 
messages from the Logger. 

1. From the Action menu, select Messages, and then select Purge. 

The Purge dialog box appears. 

2. Select the messages you want to purge by doing one of the following: 

• Select Purge All Log Messages to delete all messages currently stored in the Logger. 

• Select Purge Log Messages Created Before to purge messages created before a date and time you 
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specify. 

3. Select OK to purge the messages you selected. 
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Get Started with Log Flag Editor 
The Log Flag Editor is a utility within the Log Viewer. It allows you to assign flag values to each category of 
messages issued by a System Platform component. By switching flags on or off, you can control which message 
categories are saved to the Logger. Additionally, log flags can be used to assign message categories to other 
System Platform components. 

Most message categories are not logged by default. Typically, a component only issues error, warning, and 
informational messages. Other message categories remain inactive. 

The Log Flag Editor is primarily used as a troubleshooting tool. It enables you to activate additional message 
categories when a component begins logging error messages. This allows more diagnostic messages to be saved 
to the Logger 

Start Log Flag Editor 

You can access Log Flag Editor utility from Log Viewer. This procedure explains how to start Log Flag Editor from a 
node in which the Operations Control Management Console has been installed. 

Start Log Flag Editor 

1. Open the Log Viewer. 

2. Expand the Log Viewer list to show nodes. 

3. Select the node from the Log Viewer list that you want to enable with logging flags. 

4. On the Action menu, select Log Flags. 

The Log Flag Editor dialog box appears with a list of System Platform components associated with the node 
you selected. 

Note: To perform operations like configure, Log Flags, and Purge, you need to be an administrator or 
member of aaLoggerManagement group. 

Work with Log Flag Editor 

You can use the Log Flag Editor to manage the messages saved to the Logger. 

Log Flag Editor tasks include the following: 

• Starting the Log Flag Editor 

• Enabling log flags for a single component 

• Enabling global log flags 

• Enabling log flags for multiple components 

• Using shortcut menus 

• Saving log flag settings to a file 

• Using the Log Flag Editor on remote nodes 
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Understand log flags 

Each message sent to the Logger by an installed component belongs to a specific message category. Each 
message category has an associated log flag. 

The status of a log flag indicates whether messages that belong to the message category are logged or not. 
When a log flag is active, the messages from the category are logged. Conversely, an inactive log flag prevents 
messages from being logged. 

There are two types of log flags: 

• Default log flags 

All installed components include default log flags, which are associated with standard message categories. 

• Custom log flags 

Custom log flags apply to unique message categories that are used by only a few installed components. 

Default log flags 

All installed components include a set of default log flags for standard categories of messages. For example, all 
HMI/SCADA components can produce error, warning, and informational messages. These standard message 
categories have associated default log flags. 

The following table lists default log flags for the standard message categories. 

Default Log Flag Description 

Error The Error log flag determines if error messages are 
logged. By default, the Error log flag is active for all 
HMI/SCADA components. 

Warning The Warning log flag determines if warning messages 
are logged. A warning message indicates that an 
unexpected event occurred, but the component was 
able to recover. By default, the Warning log flag is 
active for all HMI/SCADA components. 

Info The Info log flag determines if informational messages 
are logged. 

An informational message describes the outcome of 
normal program events. 

By default, the Info log flag is active for all installed 
components. 
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Default Log Flag Description 

Trace The Trace log flag determines if trace messages are 
logged. Trace messages describe internal object states, 
variable values, and other low level data from the 
component. 

Scan On Demand The Scan On Demand log flag determines whether 
scan on demand-related MxConnection calls, 
reference counts, and suspend counts are logged. 
Also, the Scan On Demand log flag determines 
whether the routing of scan on demand messages to 
on-engine and off-engine objects are logged. 

SOD_BRO The SOD_BRO log flag determines whether tracing is 
enabled between the Lmx and the BRO. 

SOD_BROProxy The SOD_BROProxy log flag enables tracing when an 
interface is used to route a scan on demand message 
between a primitive and another primitive within the 
current object. 

SOD_PrimProxy The SOD_PrimProxy log flag determines whether 
tracing is enabled for the scan on demand interface 
between the BRO or a BRO proxy and a primitive 
proxy. 

Start-Stop The Start-Stop log flag determines if messages are 
logged that show when a component is started or 
stopped. 

Entry-Exit The Entry-Exit log flag determines if messages are 
logged that show when a program function was 
invoked. 

ThreadStart-Stop The ThreadStart-Stop log flag determines if messages 
are logged that indicate a program thread has started 
or stopped. 

SQL The SQL log flag determines if SQL messages are 
logged. Typically, SQL messages show SQL query 
strings issued by the component. 
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Default Log Flag Description 

Connection The Connection log flag determines if communication 
messages are logged. Communication messages 
describe the status of network connections between 
installed components. 

Ctor-Dtor The Ctor-Dtor log flag determines if constructor/
destructor messages are logged. These messages 
describe the status of objects as they are created and 
deleted from memory. 

RefCount The RefCount log flag determines if reference count 
messages are logged. Reference messages show the 
counts from objects that manage their life span by 
counting their clients. 

For more information about setting log flags, see Control logged messages. 

Custom log flags 

Most System Platform components have unique messages that do not belong to a default log flag category. In 
those cases, you must create custom log flags and assign them to unique component messages. 

Several components can share a custom log flag if they send similar messages that fit into that category and if 
they assign those messages to the custom log flag. Another component cannot use a custom log flag if it did not 
assign a message to that log flag. 

For more information about creating custom log flags, see Use shortcut menus. 

Manage log flags 

This chapter outlines procedures for managing log flags. It covers topics such as enabling log flags, controlling 
logged messages, and handling log settings at various levels (individual components, global, and multiple 
components). 

Control logged messages 

The Log Flag Editor provides several ways to select messages for logging. 

• You can enable log flags for an individual System Platform component. 

• You can set global log flags that apply to all System Platform components. 

• You can set log flags for multiple components, but not on a global basis. 

You can select a specific component from the Component List view to specify which categories of messages are 
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logged for that component. 

Enable a log flag 

• Select its check box. 

Disable a log flag 

• Clear its check box. 

You can select Global in the Component List view to enable a log flag for all components. If the check box for a 
log flag appears shaded, that log flag is enabled for at least one component, but not globally. 

Enable log flags for single component 

You can set log flags for a single System Platform component. The scope of the log flags apply to the message 
categories of a single System Platform component. 

Log flags for the Error, Warning, and Info message categories are active for all components. When you select a 
component, you should see these log flags already set. 

Set log flags for a single component 

1. Select a component from the Component List view. 

The Log Flags view shows the log flags for the component you selected. 

2. In the Log Flags view, select the check boxes of the log flags you want to enable. 

3. On the File menu, select Apply. 

All component messages from the selected categories are logged. 

Enable global log flags 

You can globally enable log flags to log the messages from all components installed on the selected node. 

Use log flags on a global basis 

1. In the Component List, select Global. 

The Log Flags view shows the log flags from all System Platform components installed on the selected node. 

2. In the Log Flags view, select the check box of the log flag you want to enable. 

3. On the File menu, select Apply. 

All messages associated with the selected log flag are logged. 

Enable log flags for multiple components 

If you want to log messages for multiple components, you can enable the log flags globally and select only those 
log flags for the components whose messages you do not want logged. 
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Enable log flags for multiple components 

1. In the Component List, select Global. 

The Log Flags view shows the log flags for all System Platform components installed on the selected node. 

2. In the Log Flags view, select the name of the log flag you want to enable. 

The Component view shows all components that use the selected log flag. 

3. In the Component view, select only the check boxes of the components for which you want to enable the 
selected log flag. 

The check box for the selected log flag appears shaded, indicating that at least one component that uses this 
log flag is enabled. 

4. On the File menu, select Apply. 

All messages from the enabled components that are associated with the selected log flags are logged. 

Use shortcut menus 

The Log Flag Editor includes two shortcut menus. Each menu includes a set of commands that apply to either log 
flags or System Platform components. You can show both shortcut menus by right-clicking in a view area of the 
Log Flag Editor dialog box. 

Log flags view 

After right-clicking in the Log Flags view, a shortcut menu shows the following commands: 

• All Flags ON 

This command enables all log flags shown in the view for the component selected in the Component List. 

• All Flags OFF 
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This command disables all log flags shown in this view for the component selected in the Component List. 

• Add Custom Flag 

Use this command to create a new custom log flag. The new custom log flag appears at the bottom of the list 
of the Log Flags view. 

Assign another name to the custom log flag. 

You cannot use the Add Custom Flag command to create a functioning log flag. The Log Flag Editor updates 
the permanent set of log flags for each component when you install new System Platform components on 
the selected node. 

You can create a custom flag to add a custom flag that exists on another computer, save the log flag settings 
to file, and then use the file to control messages on that other computer (if you could not do so remotely). 

• Remove Custom Flag 

Use this command to remove a custom log flag from the Log Flags view. Select the custom log flag from the 
list and right-click within the Log Flags view to show the shortcut menu. Select the Remove Custom Flag 
command. You are prompted to confirm the deletion. 

Component list view 

After right-clicking in the Component List view, a shortcut menu shows the following commands: 

• Add Component 

This command adds a new component to the Component List view. The new component appears at the 
bottom of the Component List view. You should assign another name to the new component. 

You can not use the Add Component command simply to create a functioning component. The Log Flag 
Editor only updates the Component List with new components when you install new System Platform 
components on the selected node. 

You can use this command to add a component that exists on another computer, save the log flag settings to 
file, and then use the file to control messages on that other computer (if you could not do so remotely). 

• Remove Component 

This command deletes a component from the list. You are prompted to confirm the deletion before the 
component is removed. Right-click anywhere in the Component List to show this command, although it is 
unavailable for Local or Global selections. 

If you remove a component from the list that exists on your computer, it reappears in the list when you 
restart the Logger and Log Flag Editor. Typically, you remove components from the Log Flag Editor after you 
remove System Platform components from the computer. 

Save log flag settings to a file 

The Log Flag Editor provides the capability to save your current log flag settings to a file. Generally, you save 

Operations Control Logger
Get Started with Log Flag Editor

© 2015-2024 AVEVA Group Limited and its subsidiaries. All rights reserved. Page 45



current log flag settings to a file when you want to: 

• Back up commonly used log flag settings 

• Store special-purpose log flag settings 

• Use log flag settings on another computer 

After you save the log flag settings, you can import the file settings to another instance of the Log Flag Editor. The 
components and log flags shown in the Log Flag Editor reflect those of the selected node. 

When you use the Log Flag Editor to edit a log flag settings file, the name of the file appears in the tree view 
root. The title bar and status bar continue to show the node to which you are currently connected. You can apply 
the file’s settings to the selected node or select the New command on the File menu to return to the selected 
node’s active configuration. 

Save log flag settings 

You can save the current settings of the Log Flag Editor to a file. After you save the file, you can copy these 
settings to the Log Flag Editor on another computer. 

By default, the Log Flag Editor saves the file with name of the node where the Operations Control Management 
Console is installed. You must save the file with an .aaLGF extension. 

Save log flag settings to a file 

1. Open the Log Flag Editor dialog box. 

2. Set all components and log flags as desired. 

3. On the File menu, select Save As. 

The Microsoft Save As dialog box appears. 

4. In the Save As dialog box, enter a path and name for the file. The file name must use the .aaLGF extension. 

5. Select Save. 

Import log flag files 

You can import log flag settings from a file to an Log Flag Editor session. The imported log flag settings exist for 
the duration of the current Log Flag Editor session. The original log flag settings return after you close and then 
re-open the Log Flag Editor. But, you can edit the imported log flag settings from the session and save them to a 
file again. 

Note: You can open a log flag settings file by right-clicking it from Windows Explorer and selecting Edit on the 
shortcut menu. Also, you can apply new log flag settings from a file to the selected node by double-clicking it 
from Windows Explorer. You are prompted to confirm that you want to apply the log flag settings. 

Open a log flag settings file 

1. From Windows Explorer, navigate to the folder where the file containing log flag settings is located. 

2. Right-click the file name to show an Action menu. 

3. On the Action menu, select Apply. 

A dialog box asks you to confirm that you want to apply the log flag settings to the node. 
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4. Select Yes. 

A dialog box appears and confirms that the log flag settings have been successfully applied to the node. 

Log Flag Editor on a remote node 

You can connect to a remote Log Flag Editor from your local node. After you connect to the remote node, you 
can use the remote Log Flag Editor to complete all standard tasks as if they were done on a local computer. 

Use Log Flag Editor on a remote node 

1. Open the Operations Control Management Console installed on your local node. 

2. Select Log Viewer. 

3. On the Action menu, select Connect and then Remote. 

The Connect dialog box appears. 

4. In the Computer Name box, enter the node name of the remote computer and select OK. 

The Log Viewer list refreshes and shows the remote node. 

5. Select the remote node from the Log Viewer list. 

6. On the Action menu, select Log Flags to open the Log Flag Editor dialog box. 

The node name of the remote Log Flag Editor appears in the title bar. 

Log Flag Editor user interface 

The Log Flag Editor lists all System Platform components installed on the node you selected. You enable or 
disable message logging by setting the log flags associated with the selected component’s message categories. 
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Work with the Log Flag Editor 

1. Select a System Platform component from the Component List. 

2. Set the status of log flags assigned to the component from the Log Flags View. 

3. Assign any additional System Platform component to the log flags you have selected. 

4. Select Save. 

Component list 

The left pane of the main window shows the list of System Platform components installed on the node you 
selected from the Log Viewer. The root of the component list is the node you selected from the Log Viewer list. 

After you select a component, only those log flags associated with that component’s message categories appear 
in the Log Flags View pane. You can select Global from the component list and show all log flags associated with 
all message categories in the Log Flags View pane. 

The Log Flag Editor does not dynamically update the component list. You must restart the Log Flag Editor to show 
a new component installed on the node. When you remove an System Platform component from the selected 
node, you must use the Log Flag Editor’s Remove Component command to remove it from the component list. 

Log flags view 

The top right pane of the Log Flag Editor dialog box is the Log Flags view. This view shows all log flags associated 
with the message categories of the component selected from the Component List. 

The log flags shown in this view correspond to the items shown in the Log Flag column of the Log Viewer. 

Log component messages 

• Select the check box of a log flag to log component messages that belong to that message category. 

The title of the view shows the name of the component you selected. The Log Flags view lists the default log 
flags in black text followed by the custom log flags in blue text. 

Component view 

The bottom right pane of the main window is the Component view. This view shows all components with 
messages associated with the log flag selected in the Log Flags view. You can use the Component view to select 
only those components that log messages of the log flag type selected. 

The Log Flags view and Component view dynamically interact depending on your selections. For example: 

• Select a log flag (just the log flag name) and all components with messages associated with that log flag 
appear in the Component view. 

• Select a log flag’s check box and the check boxes of all components in the Component view are enabled. 
Clear the log flag’s check box and the check boxes of the components are cleared. 

• Select a log flag’s check box and the check boxes of all components in the Component view are enabled. 
Clear one component’s check box and the log flag’s check box appears shaded, indicating that at least one 
component that uses this log flag is disabled. 
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Get Started with Log Monitor 
The Log Monitor provides a centralized utility for monitoring the status of a Local Logger as well as remote 
Loggers on all Platforms under the Galaxy group and user-configured node groups. 

The primary purpose of the Log Monitor is to provide a single place for you to determine whether any error/
warning conditions exist in the ArchestrA environment. The user interface provides icon and, if configured, 
audible notification if errors arise on a node. 

The list of Loggers shown in the Log Monitor is derived from the list of nodes in the Console Tree of the Log 
Viewer utility. It includes all Platforms under the Galaxy group, the Local node (your computer) and all configured 
node groups. Each node appears once in the Log Monitor’s logger list even if a node has been included in more 
than one node group in the Log Viewer. 

The Log Monitor dynamically changes when a user modifies the node group hierarchy in the Operations Control 
Management Console. For instance, adding new nodes or deleting existing ones is automatically updated in the 
Log Monitor logger list. This list of nodes is not persisted when you quit the Log Monitor, but rather is created 
when the utility is started. 

Start Log Monitor 

Start the Log Monitor 

1. Browse to C:\Program Files (x86)\Common Files\ArchestrA. 

2. Right-click aaLogMonitor.exe, and then select Run as Administrator. Alternatively,double-click 
aaLogMonitor.exe. 

The User Account Control dialog box appears. 

3. Select Yes. 

The Log Monitor window appears. 

If you attempt to start the Log Monitor when it is already running, the existing instance of Log Monitor is 
activated and its main window is brought to the foreground. 

Important! If the Monitor command is unavailable on the Action menu, you have not installed Microsoft’s 
.NET Framework on your computer. The .NET Framework must be installed for the Log Monitor utility to 
operate. 

Minimize and restore the Log Monitor utility 

• To minimize the utility, select the Minimize (–). A minimized Log Monitor does not appear on the task bar. It 
is represented by an icon in the System Tray. For more information, see System tray icon. 

Note: When the main window is minimized, the utility continues monitoring the status of all listed Loggers in 
the background. 

• Double-click the System Tray icon to restore the Log Monitor. 
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Quit the Log Monitor 

• Select Close (X) to quit the Log Monitor. 

Work with Log Monitor 

You can use the Log Monitor to monitor the status of a Local Logger as well as remote Loggers. 

Shortcut keys 

Shortcut Key Associated Option Menu Command Description 

CTRL+A Selects all nodes. 

CTRL+R Reset Resets selected nodes 

CTRL+N Connect Reconnects to selected nodes. 

F5 Refresh Refreshes the status of selected 
nodes. 

F1 Help Starts Help. 

Support dialog boxes 

In the process of using the Log Monitor, you may open one of the following dialog boxes. These dialog boxes 
allow you to understand and configure the underlying functions of the Log Monitor. 

• About Log Monitor Dialog Box 

• Configure Dialog Box 

About Log Monitor dialog box 

You can determine the software version and other information about the Log Monitor. 

• Select About Log Monitor on the utility’s Option menu. 

The About Log Monitor dialog box appears. 
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Configure dialog box 

You can set auto-refresh and error alert parameters. These settings are the only Log Monitor parameters 
persisted over a quit/restart of the utility. 

• Select Configure on the utility’s Option menu. 

The Configure dialog box appears. 

The Configure dialog box is comprised of the following options: 

Refresh the status every ... seconds Sets how often the Log Monitor refreshes the data for 
each node it has successfully made a connection with. 
Default value is 10 seconds, minimum is zero (turns off 
automatic refresh), and maximum is 9,999 seconds. 

Alert when Errors are detected Enables/disables an audible signal when a node’s 
Logger changes to Errors condition. The alert is in the 
form of a system beep lasting for one (1) second. 
Default setting is unchecked (disabled). 

Log Monitor user interface 

The Log Monitor user interface is comprised of the following components: 

• Main window 
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• System tray icon 

• Option menus 

• Supporting dialog boxes 

Main window 

The main window is comprised of the following components: 

• Title bar 

• Column headings 

• Logger list 

The title bar displays the utility’s name. The logger list displays, by default, the list of nodes shown in the Console 
Tree of the Log Viewer utility, including all Platforms under the Galaxy group, the Local node (your computer) 
and all configured node groups. The column headings display descriptive titles for each column, include the 
following default headings: 

Status Indicates the current status of the Logger, including 
the following states: 

• Errors – Indicates the Logger contains error 
messages and may contain warning messages. 

• Warnings – Indicates the Logger contains warning 
messages but no error messages. 

• OK – Indicates either the Logger has no error/
warning messages or that it has been reset (see 
the Reset command in Option Menus for more 
information about resetting a node). 

• Connecting – Indicates the Log Monitor is 
attempting to establish a connection with a node 
for the purpose of querying its status. 

• Unable to connect – Indicates the Log Monitor 
was not able to establish a connection with a 
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node. 

• Connection lost – Indicates the connection 
between the Log Monitor and a node has been 
broken. The icon indicates the last known status of 
the node’s Logger. 

Platform Name Indicates the name of the node. If the node represents 
a Platform in a Galaxy, it is the name of the Platform. If 
the node is not a Platform, it is the name of the node 
with a leading asterisk. 

Host Name Indicates the name of the node. 

Error Count Indicates the number of error messages recorded by 
the node’s Logger. Using the Reset command on a 
node sets its Error Count to zero (0). 

Warning Count Indicates the number of warning messages recorded 
by the node’s Logger. Using the Reset command on a 
node sets its Warning Count to zero (0). 

Last Error Indicates the timestamp of the most recent error 
message recorded by the Logger (in local time). Using 
the Reset command on a node does not change this 
data. 

Last Warning Indicates the timestamp of the most recent warning 
message recorded by the Logger (in local time). Using 
the Reset command on a node does not change this 
data. 

Note: Right-clicking on any column heading or in the logger list displays an option menu. For more information, 
see Option menus. 

Column sorting 

By default, the Log Monitor displays the list of Logger nodes in the same order that they appear in the Log 
Viewer’s Tree Console. 

• You can resort the nodes by clicking the column headings. The heading button displays an up or down arrow, 
representing ascending and descending, respectively. 

Sorting logic is defined as follows: 
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Status column Nodes in Error state, followed in order by nodes in the 
following states: Warning, OK, Connecting, Unable to 
connect, and Connection lost. 

Platform Name column Alphabetical order. 

Host Name column Alphabetical order. 

Error Count and Warning Count columns Based on the number of errors or warnings for each 
node. 

Last Error and Last Warning columns Based on the timestamp (newest to oldest and vice 
versa). 

• You can select and drag any column to a different position in the column heading bar. The columns support 
resizing by dragging the dividers or by double-clicking on a divider to auto-size the column to the widest data 
in the column. 

• You can hide a column by clicking its divider and dragging it to the preceding divider. To recover the column 
heading, select-and-drag the column divider to its original position. 

System tray icon 

When minimized, the Log Monitor main window hides from the task bar. Instead, it is represented by an icon in 
the System Tray. 

Important! When the main window is hidden in the System Tray, the utility continues to monitor node Logger 
status in the background. 

• To display the Log Monitor again, double-click the icon. 

The System Tray icon indicates the cumulative status of all nodes being monitored. Hovering your mouse over 
the icon displays the cumulative status as a tooltip. This status is updated automatically anytime there is a 
change in status information. The cumulative status reflects the following logic: 

Error status At least one node has Error status. 
One or more nodes may have 
Warning status. 

Warning status At least one node has Warning 
status but no node has Error status. 

OK status At least one node has OK status 
and no node has error or warning 
status. 

Unable to connect status The Log Monitor is unable to 
connect with all nodes in the logger 
list. 
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Connection lost status The Log Monitor has lost 
connection with all nodes in the 
logger list. The icon reflects the last 
cumulative status of all nodes. 

Note: 
- There is no Connecting cumulative status because this is transitory, to be followed eventually by one of the 
other five statuses. 
- Right-clicking on the System Tray icon displays an option menu. For more information, see Option menus. 

Option menus 

An option menu is a set of commands displayed when you right-click in the user interface. The Log Monitor 
provides two option menus. 

Right-clicking any column heading or in the logger list of the Log Monitor user interface displays the following 
option menu: 

Launch Log Viewer Starts the Log Viewer for the selected node. If this 
command is used again, the same Log Viewer is 
reactivated. 

Connect Attempts to connect to a node that currently has one 
of the following statuses: Unable to connect or 
Connection lost. If the Log Monitor currently has a 
connection to a node, this command is unavailable. 

Reset Changes the Status of a node to OK and its Error and 
Warning counts to zero (0). Used typically to 
acknowledge that a node has errors and/or warnings. 
Resetting a node’s displayed condition in the Log 
Monitor has no effect on the content of the logged 
messages in that node’s Logger. 

Undo Reset Returns the status of the node to its actual status. 

Refresh Forces the Log Monitor to do a manual refresh of the 
status information for the selected node. Only those 
nodes to which the Log Monitor has already 
connected are refreshed. Use the Connect command 
to attempt to reconnect to a node. 

Configure Opens the Configure dialog box (for more information, 
see Configure dialog box). 

Help Starts the online help for the Log Monitor utility. 

About Log Monitor Opens the utility’s About Log Monitor dialog box, 
which displays information about the application (for 
more information, see About Log Monitor dialog box). 
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Right-clicking the Log Monitor’s System Tray icon displays the following option menu: 

Open Log Monitor Restores the Log Monitor. The same as double- 
clicking the icon. 

Close Quits the utility. 

View Errors on This command is available if the cumulative status of 
the nodes is Errors. Displays a submenu list of all 
nodes that have Errors status. Selecting a node from 
the list starts the Log Viewer for that node. 

View Warnings on This command is available if the cumulative status of 
the nodes is Warnings. Displays a submenu list of all 
nodes that have Warnings status. Selecting a node 
from the list starts the Log Viewer for that node. 

Reset All Does a global reset of all nodes in the logger list. This 
command is available only if the cumulative status of 
all nodes is Errors or Warnings. 
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